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New Features:
Centaur will be the first new version of Streamline to feature significant enhancements to
the tracing engine.  These enhancements improve the quality of the tracing results, and
should help in reducing the resistance that some users have to using Streamline.  Also, a
range of new color conversion options will enable the use of Streamline as a creative tool
as well as a production-oriented utility.

Improved path matching
Pegasus includes a “Separate Shapes” option which automatically traces a line twice when
two areas share the same border.  This option ensures that the converted image has two,
separate, enclosed shapes along this border.  Centaur will ensure that the two paths along
this border match exactly, even, to the extent possible, when anchor points are deleted in
post-processing.  These improved path-matching capabilities will also be applied to
posterization.  In Pegasus, a posterized illustration consists of regions of color that don’t
necessarily border each other exactly, resulting in undesirable gaps in the converted image.
Centaur will ensure that a posterized image has virtually no gaps between the color
regions.

Expanded color options for posterization
Color and grayscale posterization in Centaur has been significantly overhauled.
Enhancements include the following:
• Posterize an image using a set of pre-defined custom colors, such as Pantone colors.

If desired, tints of these colors can be generated automatically.  Using tints of a single
color can result in an effect similar to a photographic duotone.

• Posterize using an unlimited number of colors.  Unlike Pegasus, Centaur will be able
to create a fill color for each region independently when this option is used, resulting
in better color matching with the original image.

• Using a “Complexity” slider, the user can control how finely Centaur distinguishes
between color regions and how many paths are created as a result.

• Pegasus always assigns colors to paths by averaging the colors of all of the pixels in
that region.  This can result in muddier colors when images are noisy or heavily
dithered.  In Centaur, this color averaging can be disabled.

Cleanup tools
In Pegasus, the only editing that can be performed on converted vectors is the deletion of
points.  Centaur adds tools for adding points, moving points and curves, and also for
automatically converting segments to curves, circular arcs, lines, and
vertical/perpendicular lines.  These tools make it easy to correct for tracing errors
resulting from poor scans.
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Multiple conversions
Sometimes different areas of an image are best suited to different conversion settings, but
Pegasus only allows an image to be converted using a single setting.  Centaur will allow
the user to interactively select regions of the source image and convert them using
different settings.  The final, converted artwork can be built up through a series of
successive traces, ensuring the best possible trace on all portions of the image.

Interactive line thinning
In Pegasus, the Centerline method often requires that lines in an image be “thinned” by
stripping away pixels from either side of the line.  The best quality tracing occurs when all
lines are thinned to a one pixel thickness.  The resulting image “skeleton” is used as the
basis for the autotrace, even though the final thickness of the lines may be based on the
original image.  The user must choose the number of thinning steps prior to conversion.
Too few steps may result in an imperfect trace, while too many steps can shorten the
length of the lines.

Centaur will provide an “interactive thinning” option that gives the user more control over
this process.  With interactive thinning, the user can perform thinning steps one at a time,
viewing the results of each on the image.  The user also can edit the resulting image
skeleton before completing the conversion, ensuring that lines that were unexpectedly
shortened or distorted are traced correctly.

Smooth direction points function
While smooth points are much easier to edit, an autotrace program tends to create most, if
not all, points as corner points.  Centaur will include a function, with three different
tolerance levels, that will convert corner points that are almost parallel into true, smooth
points.

Secondary New Features in Centaur
User-selectable scratch disk
Instead of always defaulting to the startup disk, Centaur will allow the user to specify the
disk to use as a scratch disk, providing more flexibility to those whose startup disks are
full.

Thumbnail preview in Open dialog
Similar to Photoshop, Centaur will allow the user to preview an image before opening it.

Improved color import/export
Pegasus could only import color palettes, or styles, from Illustrator files.  Centaur will
allow users to selectively import colors from an Illustrator file, and also selectively export
color palettes created within Centaur.  A default color file can be created to be used each
time Centaur is launched.
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Pop-up menu in paint style dialog
Many of the color functions are made more accessible via this pop-up menu.  New options
include Keep Tints, which lets a new custom color be applied to multiple selected objects
without altering their original tint values.  The Keep Tints option is especially useful when
applying colors to a grayscale posterization.
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Centaur User Interface
Following is the Centaur interface.  Only those items that have been changed from
Pegasus are described in detail.

Main Image Window

Unlike Pegasus, Centaur will allow a series of conversions to be done on a single source
image, combining each conversion into a single illustration file.  This ability makes it
possible to convert different regions of an image using different conversion settings.  The
final illustration can be built up as a series of successive conversions.

In Pegasus, there are two image modes:  raster and vector.  When a file is first opened, the
user is in raster mode, and can edit the bitmap prior to conversion.  Converting an image
automatically changes the mode to vector.  The only way to return to raster mode after a
conversion is to undo the conversion or open a new file.

Centaur requires giving the user control over these modes, so that he/she can return to
raster mode multiple times to convert different portions of the image.  To make it easier to
switch between modes, the image window will be modified as follows:
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The window now features an area at the top with two pop-up menus.  The pop-up menu
on the left is for switching between raster and vector modes, and includes the following
options:

Pixel Image
This is the bitmap image prior to conversion.  It is based on the original source
image, but will include any edits that have been performed since the file was
opened.

Converted Art
This is the converted artwork consisting of vector paths.

Template
This mode is comparable to enabling the “Show Template” command when in
vector mode in Pegasus.  The converted artwork is displayed on top of the pixel
image, but only the converted artwork is editable in this mode.

When a file is first opened in Centaur, the image window will be in Pixel Image mode.
The pop-up menu will be available, but Art and Template will both be disabled choices.

After a file is converted, the mode of the image window will automatically change to Art.
Now, all three items in the pop-up menu will be available.  If the user chooses Template,
the display in the image window will change to show the pixel image as a template behind
the converted artwork, but nothing else will change.  If the user chooses Pixel Image, the
current converted artwork will be stored prior to displaying the bitmap image.

In most cases, selection regions will be remembered when the user switches between
modes.  In other words, when the user returns to viewing the pixel image, the same areas
should be selected as when he/she last viewed the image.  Likewise, when the user returns
to viewing the converted artwork, the same objects should be selected as were selected
when the artwork was last viewed.

The second pop-up menu controls the preview mode for vector artwork.  As in Illustrator,
the choices are Preview (view all objects with fills and outlines), Preview Selected (view
only selected objects with fills and outlines), and Artwork (view only object outlines).
This second pop-up menu does not apply when the window is in Pixel Image mode, so it is
greyed out.
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File Menu

The File menu has three changes from the one in Pegasus.  The Import Styles command
has been removed, because this function is now integrated into the Paint Style palette.
The Convert Selection Edge command is a new addition to the menu, as is the Scratch
Disk option in the Preferences sub-menu.

Convert Selection Edge
Essentially the same thing as performing a conversion in Pegasus with “Convert Selection
Edge” enabled in the Color/Grayscale Setup dialog.  This command is greyed out when no
region of the current pixel image is selected.  When Outline is the current conversion
method, this command creates a filled path out of the current selection region.  When
Centerline is the current conversion method, this command creates a stroked but not filled
path out of the current selection region.  The keyboard shortcut for this option is
[Command]-N.

Preferences/Scratch Disk...
Pegasus uses a scratch disk while performing conversions, but the scratch disk is always
the same as the startup disk, and there is no way for the user to control this.  On systems
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where the startup disk does not have very much free space, this can impose limitations.
Centaur allows the user to change the scratch disk, if desired:

The pop-up menu lists all of the drives that are available to the system.  The chosen
scratch disk preference is saved in the preferences file and used the next time that Centaur
is run.  If the chosen scratch disk is no longer available, then the scratch disk will revert
back to the Startup disk.

There are two dialogs reached via the File menu that have been modified in Centaur:

Open dialog
Centaur will feature a revised Open dialog that includes a thumbnail preview option similar
to the one available in Photoshop.
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Show Thumbnail
Enabling this checkbox displays an image thumbnail, when available, for any
selected image file.  The thumbnail appears on the left side of the dialog.  When
this checkbox is disabled, the size of the dialog shrinks, and the thumbnail preview
area is removed.

Create
Clicking this button creates a thumbnail for the currently selected image file.

Preferences/General...
The General Preferences dialog now has one new option:

Eliminate hidden paths
When this checkbox is enabled,  multiple conversions of an image will not result in
one path that completely obscures one or more paths from an earlier conversion.
Any pre-existing paths that are completely obscured by the new conversion region
are automatically deleted.  This checkbox is enabled by default.
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Edit Menu

There are two new items on this menu:  Smooth Direction Points and Convert To.  Both
of these items have sub-menus.

Smooth Direction Points
In order to trace curves as closely as possible, Centaur, like Pegasus, creates most points
as corner points rather than smooth points.  Converting direction points that are almost
parallel into smooth points can result in a more easily editable path that is only slightly less
accurate.  It can also result in a file that prints more cleanly.  The Smooth Direction Points
command will scan paths for points that are at nearly 180 degrees from each other and
convert these into smooth points.  The Minimum, Medium, and Maximum options differ in
the amount of tolerance allowed.  These commands apply to the currently selected paths
or, if no paths are selected, to all of the paths in the artwork.  Each of these options has a
keyboard shortcut, as illustrated above.

Convert To
This menu item is for cleaning up converted paths by converting them into standard
shapes.  The choices in the sub-menu are Circle, Oval, Square, and Rectangle.  In each
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case, the selected path will be converted to the chosen shape at a size that most closely
matches the original proportions of the object.

View Menu

This menu is unchanged from Pegasus, with the exception that some keyboard shortcuts
have been added for greater consistency with Illustrator:

[Command]-[Option]-Y: Preview Selection
[Command]-[Control]-T: Hide/Show Toolbox
[Command]-[Control]-I: Hide/Show Info

Options Menu

This menu is unchanged, but there are a number of changes to the dialogs that are reached
via this menu.

Conversion Setup
Centaur includes one new option in the Conversion Setup dialog–Interactive Thinning.
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Interactive Thinning
Enabling this checkbox allows greater control when using the Centerline method of
conversion.  Line thinning is the process of stripping away layers of pixels from a
line in order to find the center of the line.  Stripping away too many layers can
shorten the line, while stripping away too few layers can cause inaccuracy in the
conversion.  During conversion, if interactive thinning has been enabled,
Streamline will pause after the number of thinning steps indicated by the Line
Thinning slider have been completed.  The image window, with the interactive
thinning dialog on top of it, will look as follows:
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At this point, the original bitmap will probably have been modified by the thinning
steps already taken.  Using the standard bitmap editing tools, the user can edit this
modified image to correct any potential problems in the  image.  For example, if
too much line thinning shortened the length of a line, it can be extended, and if two
lines seem to be meeting at an odd angle, the intersection can be edited.

The interactive thinning dialog contains the following choices:

Thin More
Clicking on this button causes the lines in the image to be thinned by one
more pixel, and then returns the user to interactive thinning mode.

Cancel
Clicking on this button cancels the image conversion and returns the user to
Pixel Image mode.

Done
Clicking on this button accepts all changes and completes the conversion
process.

At the bottom of the interactive thinning dialog, a status line will indicate the total
number of thinning steps that have been taken.  This number initially will equal the
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number of steps defined in the Conversion Setup dialog, but will then increment
each time the Thin More button is clicked.

During interactive line thinning, most menu items will be unavailable, with the
following exceptions:

File menu:  Save Pixel Image As...

Edit menu: Undo

View menu:  Zoom In, Zoom Out, Actual Size, Fit in Window, Show/Hide
Toolbox, Show/Hide Info

Note:  The Undo command in the Edit menu will also be able to undo the effects of
the Thin More button.

Paint Style...
The Paint Style palette in Centaur differs in several ways from the one in Pegasus.  The
changes can be summarized as follows:

• A pop-up menu button has been added to the top of the palette.
• The Auto checkbox and Apply button have been removed, and Auto Apply is now the

default mode of operation.
• Some functions of the Custom Color dialog in Pegasus have been integrated into the

Paint Style palette of Centaur.
• Custom Colors can now be tagged with a bullet.  Marking the colors in this way

allows the user to specify a subset of the custom color list for use in posterization or
export.

Below is a depiction of the Paint Style palette in all five color modes (none, black, white,
CMYK, and custom):
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The general layout of these palettes is the same as in
Pegasus.  The Auto checkbox and Apply button are
gone, and the lever for expanding the dialog has
been moved to the left side of the palette.

Each of these versions of the Paint Style palette
works as it does in Pegasus.  When a new color is
chosen, it is automatically applied to any selected
object (unless the Auto Apply option in the pop-up
menu has been disabled).

The custom color version of the Paint Style dialog
has more changes, because it now allows you to
mark a subset of the color list for use in
posterization.

Clicking the mouse in the left column of the custom
color scroll list toggles a bullet on or off in that

column.  In this way, a subset of the total custom color list can be “tagged” for export or
for use in posterization.  Clicking on the icon above the bullet column toggles between
showing all colors or showing only tagged colors.  Notice that the icon changes to
represent what is being shown in the list.

[Note:  If your current view is tagged colors only,
and you “untag” one of the colors, the color does
not disappear from the list.  The color should be
greyed-out, so that the user can click again to re-tag
it.  If the color is not re-tagged, then the color will
no longer appear once the user exits the “tagged-
only” view and returns.]
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The pop-up menu is essentially the same for all five versions of the Paint Style palette, but
certain items are greyed out for some versions of the palette:

New color...
When the paint style palette is in custom color mode, this menu item calls up the
Custom Color dialog (see below), with the current swatch color displayed as the
current color, and “New color x” defined as the name, where x is a unique number.
When the user clicks “OK” to exit the dialog, the new color is added to the scroll
list.

When the paint style palette is in any mode other than custom colors, this command
is called “Save color...” and launches the Custom Color dialog with the currently
defined color added to the scroll list.  The name of the new color will be “New
color x,” and the name edit field should be active.

When in a mode other than custom color mode, and no color is defined, the “Save
color...” command should be disabled.  When in custom color mode with no swatch
color defined, the “New color...” command should still be available, but white
should be treated as the currently defined color.

Edit...
Brings up the Custom Color dialog, highlighting the currently selected color from
the scroll list.  This option is disabled when not in custom color mode.  The Custom
Color dialog looks just like it does in Pegasus, with the exception that the custom
color scroll list has been updated to accommodate tagged colors:
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The icon at the top of the scroll list works just as it does in the Paint Style dialog.
It toggles between showing all colors and showing only tagged colors.

NOTE:  A shortcut to this dialog is double-clicking on any color in the custom
color scroll list.

Tag / Untag
Places/removes a bullet in/from the left column of the scroll list next to the
currently selected color.  This command will toggle based upon the current status of
the selected color.  This command is inactive when not in custom color mode.

Delete
This button deletes the selected color from the custom color scroll list, after
displaying a confirmation dialog.  This command is inactive when not in custom
color mode.

Auto Apply
This option is enabled by default.  Disabling this option removes the checkmark
next to the menu option, and prevents any changes in the Paint Style palette from
being applied to selected objects until the user hits [Return].

Keep Tints
This option is enabled by default.  When enabled, tint values are maintained even
when an object’s color is changed.  (e.g.  If an object is filled with 50% black, and
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the user selects a custom color to fill that object, then it will be filled with a 50%
tint of that custom color.)

Import...
Displays a standard file open dialog from which the user can select a file with a set
of custom colors to import.  The custom colors chosen will be appended to the set
of custom colors currently loaded.   If duplicate names are found, then a tilde (~) is
added to the end of the color name being loaded.  (e.g. “Red” becomes “Red~.”)

After selecting “Open” from the Open dialog, the following dialog is displayed:

This dialog allows the user to selectively choose colors to load from the selected
file.  The listbox on the left displays all of the custom colors contained in the file.
The listbox on the right displays those colors that will be loaded.  Both listboxes
support multiple selections.

Add
Deletes the selected colors from the listbox on the left and adds them to the listbox
on the right.

Add All
Deletes all of the colors from the listbox on the left and adds them to the listbox on
the right.

Remove
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Deletes the selected colors from the listbox on the right and adds them back to the
listbox on the left.

Source File
Displays the name of the file containing the custom colors.

Place tags on imported colors
When this checkbox is enabled, all imported colors are automatically tagged with a
dot in the custom color list.  This makes it easy to load a few colors for the express
purpose of posterization

Import
Loads all of the colors in the listbox on the right into the current document.

Export...
Displays the following dialog:

This is a standard Save dialog, with the exception of the checkbox at the bottom.
The default name to save to is “Default custom colors.”  [NOTE:  Centaur will ship
with a default set of custom colors, but this internal list can be overridden with a
Default custom colors file .]

Export tagged colors only
When this checkbox is enabled, only the tagged colors in the current custom color
list are exported.  This checkbox is disabled by default.
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New Centaur Color/Grayscale Dialog
With the addition of several new options, the Color/Grayscale Setup dialog has become
much more cluttered, and it may prove to be very confusing for someone who doesn’t
understand what all of the options mean.  In redesigning the dialog, I’ve attempted to do
three things:

1. Organize the controls logically so that related items are grouped together, and can be
understood as a whole.

2. Organize the dialog so that the primary decision the user needs to make—specifically,
how many colors do they want—is at the top.

3. Rename and reconfigure the controls as necessary so that they indicate the results they
obtain moreso than the internal procedures they change.

That said, here’s the dialog.  The picture that follows shows most controls as active, but,
in practice, many controls will be greyed out at any given time:
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Posterization
This pop-up menu is a new control that combines options that previously were contained
or implied elsewhere in the dialog.  The main purpose of this control is to allow users to
make a simple, top-level decision when they first open the dialog.  This choice will then
control which other options in the dialog are applicable.  The goal is to prevent users from
having to deal with more information than they have to.

The options in the pop-up menu are as follows:



1/14/97 Adobe Confidential 25
Centaur Specification Draft III

Limited
This option allows the user to define a maximum number of colors to use in the
drawing.  The colors will be generated by Streamline

Unlimited Colors
This option will result in an unlimited number of colors being generated by
Streamline, as required by the image.

Use Custom Colors
The colors in the current custom color list will be used to fill the paths.

Black & White Only
The image will be traced as two-color, black & white line art.

Maximum # of colors
This is the same as the control in the current dialog.  It is only fully functional if “Limited
Colors” is chosen in the Posterization pop-up menu.  If “Unlimited” or “Black & White
Only” posterization is selected, this control is entirely greyed out.  If “Use Custom
Colors” is selected, only the entry field is greyed out, and it displays the actual number of
custom colors.  If “Tagged Colors Only” is enabled, then only the number of tagged colors
is displayed.  If “Generate Tints” has been enabled, then the number of colors in the entry
field should be multiplied by 10.

Noise Reduction
This is the same as Edge Smoothing in the current dialog.  Now that there are several
different controls in the dialog that all affect the detail and resolution of the image or
resulting trace in some way, I felt it was necessary to be more specific about what each
control does.  This option reduces single-pixel noise by averaging adjacent pixels, so I
think that Noise Reduction is a more accurate description than Edge Smoothing.  Let me
know if anyone disagrees.

The rest of the dialog has been organized into three groups.  The first group, Custom
Color Options, contains all of the controls that deal with the custom color list in some
way.  The second group, Color Conversion, contains controls that affect the color
posterization procedure.  The third group, Black & White Conversion, contains controls
that affect the tracing of line art.

Tagged colors only
This checkbox forces Streamline to use only the tagged colors in the custom color palette
during the conversion. This checkbox is only available when posterization popup is set to
custom colors.
Generate tints
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This checkbox  Streamline to use up to 10 tints of the available custom colors during
conversion.  The tints are chosen as blends of the color and white evenly over the 0-100%
white.  This checkbox is only available when posterization popup is set to custom colors.
Add new colors to custom color list
This checkbox instructs Streamline to add the colors that are generated to the custom
color list after conversion. This checkbox is only available when posterization popup is set
to limited colors.

Complexity
This is the same thing as Granularity in the current dialog.  I tried to rename this control to
more closely reflect how it affects the tracing.  The one consistent thing this control does,
regardless of the other settings in the dialog, is increase or decrease the  number of paths
in the finished trace.

Reduce detail
This is the reverse of High Detail Posterization in the current dialog. We’ve decided to
leave high detail enabled by default, and the only time someone would want to disable high
detail posterization is when they want to reduce the detail in the traced illustration.
Therefore, I’ve changed the name of the control and left it disabled by default.  When this
option is enabled, then the image resolution is not doubled before conversion.

Color averaging
This one checkbox takes the place of the radio buttons and proxy images for “Average
color” and “Most common color.”  After playing with these options a bit, I’ve decided
that they’re not important enough to get so much real estate in the dialog.  When “Color
averaging” is enabled, the average color is used.  When it is disabled, the most common
color is used.  This checkbox should be enabled by default.

The rest of the options under Black & White Conversion are the same as they have always
been.

The only remaining issue is the Preview button.  Given all of the new color options, this
button no longer accurately previews what the final, traced imaged should look like.  I
think we have two options:

1. Reconfigure the preview for color posterization so that it takes into account the
settings for Complexity, Maximum # of Colors, and Posterization.  I expect that this
would be more work than it is worth, and would probably take almost as long to
generate as it actually takes to trace the image.

2. Disable the Preview button unless “Black & white only” posterization is selected.

Assuming that we go with option 2, following is a picture of what the dialog will look like
when each of the Posterization options are selected.  In order to make this more
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understandable when faxed, I’ve erased disabled controls entirely rather than just graying
them out.
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Note in the above dialog that the Maximum # of colors field is greyed out, but still
displays pertinent information.
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The rest of the dialog remains as it was in Pegasus.

Settings...
Changes in the Conversion Setup and Color/Grayscale Setup dialogs require that changes
be made to the Settings dialog as well:
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Under the Conversion Setup/Accuracy heading there is one new item:

Interactive
This item is followed by a “Yes” when Interactive Thinning is enabled.

The format of the items under the Color/Grayscale Setup heading have changed
substantially, to reflect the changes in the Color/Grayscale Setup dialog.  The first item
under this heading will reflect one of four options:

Black & White only
x Colors (where x is the number in the # of colors field)
Unlimited Colors
Use Custom Colors

The rest of the items directly reflect the status and/or value of the corresponding controls
in the Color/Grayscale Setup dialog.  If Black & White only is the Posterization option
chosen, then the Color Conversion listing in the Settings dialog is replaced with B&W
Conversion, as follows:
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Also note that one item has been removed from the Color/Grayscale Setup section.
“Convert Selection Edge” no longer appears, because a separate command for this
function has been added to the File menu.
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Tool Palette

Several new tools have been added to Centaur’s tool palette.  These new
tools are designed for editing converted illustrations.  In addition, some of
the other tools have been rearranged for the sake of greater consistency with
other Adobe applications.

Pegasus featured separate “+” and “–” magnifying tools.  In Centaur these
are condensed into a single tool, consistent with the functionality of
Illustrator and Photoshop.  The default mode of operation for this tool is to
zoom in.  Holding down the [option] key changes the tool to zoom out.

The new editing tools in Centaur are designed so that all editing operations
can be performed with a single tool in combination with shortcut keys, but
separate tools are provided for users who don’t know the shortcuts.  The
new tools are as follows:

  Adjust Curve

Default Behavior:  Click and drag on a point to move it.  Click and drag on a path to
adjust it as a simple curve.  Automatically converts an existing straight line segment into a
curve when you click on the path rather than a point.

[Shift]:  Constrains the segment to be a circular arc, adding additional points as necessary.

[Control]: When pointer is over a point, becomes the Delete Point tool.  When cursor is
over a path segment, becomes the Add Point tool.  (This is just like the Pen tool in
Illustrator works.)

[Option]:  Switches to the Adjust Line tool.

  Adjust Line
Default Behavior:  Click and drag on a point to move it.  Click on a path segment to
convert it into a straight line.  Also allows you to drag the segment in any direction,
pulling its endpoints with it.

[Shift]:  Constrains the line segment to be horizontal, vertical, or at an angle of 45
degrees.  Moves the endpoints as necessary to make this so.
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[Control]: When pointer is over a point, becomes the Delete Point tool.  When cursor is
over a path segment, becomes the Add Point tool.  (This is just like the Pen tool in
Illustrator works.)

[Option]:  Switches to the Adjust Curve tool.

Add Point

Default Behavior: Adds a new point on the path segment where clicked.

[Option]:  Switches to the Delete Point tool.

Delete Point

Default Behavior: Deletes the point underneath the pointer when clicked.  Clicking and
dragging creates a bounding box, and deletes all points within the bounding box, but only
on the currently selected path.

[Option]: Switches to the Add Point tool.

Each of these path editing tools, by default, will be applied to the closest selected path to
the location of the mouse click.  If no selected path is within a given tolerance of that
location, then the closest path within that tolerance is selected automatically, and the
editing operation is applied to it.  (The exception to this rule is the Delete Point tool when
used in click-drag mode.  This tool will only apply to a previously selected path.)

Summary of Tools:
Tool:                                      Click On:                               Drag?:            Shift

Add Point Path No
Delete Point Point No
Move Point Point Yes
Make Line Path No Horiz/Perp.
Make Horiz/Perp. Line Path No Reg.
Make Circ. Arc Path Yes Reg.
Make Arc Path Yes Circ.


